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The NERC Field Spectroscopy Facility has created a number of Excel templates
which can be used to post process the spectral data files from the ASD FieldSpec
Pro and FieldSpec 3 spectroradiometers. The templates will allow multiple spectral
data files to be compiled into a single spreadsheet, scaled for relative and absolute
reflectance values or converted to spectral radiance or irradiance values. ASD
spectral data files are saved in a binary format and must be converted to ASCII
format using the ViewSpec Pro® program, before being processed by the FSF Excel
template. Note: to ensure that the macros in the templates run correctly please
close all other excel spreadsheets while you use the template.
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1. Using ViewSpec Pro to Convert ASD Binary Files to ASCII
The application ViewSpec Pro from ASD includes many useful features such as
graphing, scaling, 1% derivative and conversion of the spectrometer’s binary files
into ASCII text files. For the purpose of this guideline we will only use the ASCII
Export function. The application is installed on each of the facility’s computers and
is also available for the Analytical Spectral Device’s website ftp:/ftp.asdi.com/Software/
contact FSF for further details.

e Start the ViewSpec Pro application.

Configuring ViewSpec Pro

The application can save the path/directory to your ASD spectrum files and the

converted text files.

e From the Setup menu click on the Input Directory to select a New Directory
Path to your ASD binary data files.
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' ViewSpec Pro is installed on the FSF computers and is available from the Analytical Spectral Devices website



After selecting the default Input Directory you are offered the opportunity to make
the Output Directory match the Input Directory. Alternatively, you can select a
different path/directory using the Setup /Output Directory menu.

Open ASD Spectrum (Binary) Files

ViewSpec Pro can open and process large numbers of files although graphing is

limited to 14 spectra.

e From the File menu select Open and highlight the ASD White-Ref or radiometric
binary files for importation.

e Click Open to bring the files into ViewSpec Pro.

Converting ASD Binary Files to ASCII text

The file list is shown in the application window.

e Highlight each file in the list.

e From the Process menu select ASCII Export.

e Ensure the boxes/buttons circled in red are selected.

e * NOTE The new ASD ViewSpec Pro software allows different data formats and
derivatives to be selected if required — see the dialogue box below. ‘DN’ and
derivative - ‘none’ are recommended.

e Click OK to convert the files to ASCII and save them in the Output directory.

e Close the ViewSpec Pro application.
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2. Post Processing ASD White-Ref Reflectance Data Files

The ASD FieldSpec Pro and FS3 spectroradiometers have a feature for saving the
reference measurement into the computers RAM memory (White Reference). All
subsequent Target reflectance measurements are calculated with respect to the
White Reference. The data file saved to the disk includes the wavelength scale and
the calculated reflectance of the target.

The alternative method for taking Reflectance Measurements with the ASD
FieldSpec requires two raw files to be saved to the disk, the first contains the signal
intensity values for the Reference Panel, the second saved file contains the signal
intensity values for the Target. Reflectance values are calculated by post processing
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these two files using the second FSF template ASD Raw Reflectance Data
Template_Ver 03.XLT- ref section 3.

Notes:
i) ASD binary files must be converted to ASCII text files before importing into
this template.
ii) This template will not process ASD raw reflectance data files.

Excel Macro Security Level

Before the Excel templates can be opened it is necessary for the Macro Security

level to be set to allow the template’s macro and Visual Basic code to be enabled.

e From the Excel Tools menu select Options and the Security tab.

e Click on the Macro Security button and change the Security Level to Medium.

This will allow the macros to be manually enabled when opening the Excel

template.

e If using Excel 2007 click on the ‘office’ button in the top left corner of the
screen. Excel options - Trust center. Trust center settings - macro settings -
enable all macros - OK.

Opening and Saving the ASD White-Ref Reflectance Template

e Start Excel

e From the File menu Open and select the FSF |
Excel template:

Security Warning

“\\geoshome 1.geos.ed. ac. uk\emadell\Excel Worksheets\Excel Templates for
Field Spectrometers\Post Processing\Reflectance\GER 1500 DFOV Reflectance
Diats File Reader_Rev D (Beta). ¥LT" contains macros.

ASD White-Ref Reflectance Template Ver 03.XLT

Macros may contain viruses. It is usually safe to disable macros, but if the
macros are legitmate, you might lose some functionality.

e In the Security Warning dialog click the Enable
Macros button.

[.pisable Macros ErebleMacos | [ MareInfo

Note:
As the template is a read only document it needs to be opened and renamed as
an Excel .XLS worksheet prior to running the macros.
In Excel 2007, it must be saved as a ‘macro enabled workbook’ .xIsm file.

The new spreadsheet will open on its Input Parameters worksheet as shown below:
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e Save the spreadsheet as an .XLS document (or .xIsm in Excel 2007) with a
name and in a directory of your choice. The new name is displayed in cell H36
of the Input Parameter worksheet. Do not enter the file name into cell H36.

Setting up the Excel Template Parameters

The Input Parameter worksheet allows the user to select the path\directory and
root filename for the reflectance panel calibration file, as well as the actual
reflectance panel used for the reference measurements.

e Click on cell H27 to bring up the pop down menu button. Click on the button to
display the serial numbers of the NERC FSF calibrated reflectance panels.
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Reference Panel selection menu L= - -
e Select the serial number of the panel used during the White Reference

measurement. This will be used to convert the relative reflectance values into
absolute spectral reflectance data. If you do not require absolute reflectance
data select Panel Not Selected from the list.

e Sun Angle Correction has not been implemented into the template at this
stage.

e Set the Reflectance Scale (cell H33) to the desired level. Typically this is 1 or
100.

e The calibration data for the Reference panels is stored in a separate Excel
spreadsheet, available from the FSF website. Carefully enter into cell P27 the
directory path where this spreadsheet is located on your computer.

e Enter into cell P30 the name of the Reference panel calibration spreadsheet
file. NOTE: It is important to ensure that the Reference panel calibration file
corresponds to the same year that the measurements were taken. Files from
previous years are archived on the FSF website, please contact FSF for further
advice on this.

Macro for Importing the Selected Reference panel Calibration Data

Before the data can be processed it is necessary to run the macro /load_pan_cal.
This will read the selection in cell H27 and import the calibration data from the
panel calibration spreadsheet into column B of the Absolute Reflectance worksheet.

e Use the short-cut keys Ctrl + b to load the selected panel calibration data.

Importing Data with the ASD White-Ref template Macro
The Excel template can import up to a maximum of 102 ASD ASCII reflectance data
files from the selected directory.
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load_ASD_Dialog macro or the short-cut keys Ctrl + p to bring up the dialog
box and then select the text files (already converted to ASCII in section 1) you

wish to process.

The output ASCII text file from ViewSpec Pro for a White Ref reflectance binary file
comprises of a header with measurement parameter information, a column with the
wavelength scale and a column with the relative spectral reflectance spectrum.

The template and its Macro \ Visual Basic code import all the White-Ref reflectance
data files that have been selected from the ‘file open’ dialog box.
During the importation procedure the data files names will appear and disappear
from the Windows task bar. The procedure can take several minutes depending on
the number of data files selected and the speed of your computer.

The ASD ASCII Files Worksheet

This worksheet shows the original data
with the file header slightly reformatted.
In column D in the example the file
header information was deselected in
ViewSpec Pro.

Note:
During importation the Excel macro
checks each file’'s header to confirm if
the files are genuine White Reference
measurements. Data files which do not
comply are not imported.

The Absolute Reflectance Worksheet
Relative spectral reflectance data from the
ASD ASCII Files worksheet is multiplied
with the calibration data of the selected
Reflectance panel (Reference Panels
worksheet, cell H27) to give the Absolute
Spectral Reflectance values.

A B C D
ﬂ Filename: Lascar.000.txt Lascar.001.txt Lascar.002.txt
2 H_Filename: Lascar.000 Lascar.001 Lascar.002
3 | ASD Serial # 6449 6449
4 INI Cal # 1 1
5 |Program Version: 2.03 2.03
6 File Version: 4.03 4.03
7 File Date: 08/03/2005 08/03/2005
8 File Time: 16:17:39 16:33:45
9 | VNIR Int. Time: 136 136
10 | VNIR Channel #1 350 350
11 | Wavelength Int: 1 1
12 Averaging: 500 500
13| SWIR1 Gain 52 52
14| SWIR1 Offset 2073 2073
15 SWIR2 Gain: 27 27
16 SWIR2 Offset: 2086 2086
17 Join 1: 1000 1000
18 Join 2: 1830 1830
19 VNIR DC: subtracted subtracted
20 | DC Averaging: 500 500
21 DC Time: 16:06:09 16:27:14
A | B C
1 | Filename: Lascar.000 L3
2
3
4 Ref. Panel Absolute
5 |Wavelength SRT 13160A Reflectance
6 350 95.2% 10.54
7 351 95.2% 10.66
8 352 95.2% 10.68
9 3583 95.2% 10.56
10 354 95.3% 10.72
1 355 95.3% 10.76
12 356 95.3% 10.75
13 357 95.3% 10.83

Graphing Absolute Reflectance data with the Template Macro
A simple graphing macro plot_abs_reflect (Ctrl + g) is available to graph the first
25 spectra in the Absolute Reflectance worksheet.
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e Select from the Tools\Macro|Macros menu plot_abs_reflect or use the macro
short-cut keys Ctrl + g to plot up to 25 spectra in the Absolute Reflectance
worksheet.

Absolute Reflectance
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X-Y scatter plot of absolute reflectance data using the plot_abs_reflect macro (short-cut
keys Citrl + g)

Removing data from the Atmospheric Water Absorption Bands

Under certain measurement conditions the atmosphere can strongly absorb the
incident downwelling radiation in two bands (1350-1460nm & 1790-1960nm) of the
shortwave infrared region. As a result the reflectance data can appear very noisy in
these regions. The template macro rem_wtr_bands deletes data across these
bands in Absolute Reflectance worksheets. Note the ASD ASCII data remains
untouched by this macro.

e Start the rem_wtr_bands Marco from the Tools \ Macro\ Macros menu or use
the short cut keys Ctrl + w
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X-Y scatter plot of absolute reflectance after the data in the water bands has been removed
using the macro rem_wtr_bands (short-cut keys Ctrl + w)

Note:
The spreadsheet can now be saved for further processing.
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3. Post Processing ASD Raw (DN) Reflectance Data Files

In section 2 above the ASD White Reference reflectance files are processed using
the Excel template ASD White-Ref Reflectance Template_Ver 03.XLT. This section
uses the Excel template ASD Raw Reflectance Data Template Ver 03.XLT to
process pairs of raw digital number data files into relative and absolute reflectance
spectra.

e All the ASD raw binary data files must be first converted into ASCII format

using ASD ViewSpec Pro - ref to Section 1 in this guide.

Excel Macro Security Level

Before the Excel templates can be opened it is necessary for the Macro Security

level to be set to allow the template’s macro and Visual Basic code to be enabled.

e From the Excel Tools menu select Options and the Security tab.

e Click on the Macro Security button and change the Security Level to Medium.

This will allow the macros to be manually enabled when opening the Excel

template.

e If using Excel 2007 click on the ‘office’ button in the top left corner of the
screen. Excel options - Trust center. Trust center settings - macro settings -
enable all macros - OK.

Opening and Saving the ASD Raw Reflectance Data Template

e  Start Excel

e From the File menu Open and select the FSF
Excel template:

Security Warning

"\\geoshome 1.geos.ed ac,uk\cmadell\Excel Worksheets\Excel Templates for
Field Spectrometers\Post Processing\Reflectance\GER 1500 DFOV Reflectance
Diats File Reader_Rev D (Beta) XLT" contains macros,

ASD Raw Reflectance Data Template_Ver 03.XLT

Macros may contain viruses, It is usually safe to disable macros, but if the
macros are legitmate, you might lose some functionality.

e In the Security Warning dialog click the Enable
MaCI‘O button. [ Disable Macros [ Enable Macros ][ Mare Info

Note:
As the template is a read only document it needs to be opened and renamed as
an Excel XLS worksheet prior to running the macros.
In Excel 2007, it must be saved as a ‘macro enabled workbook’ .xIsm file.

The new spreadsheet will open on its Input Parameters worksheet as shown below:
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1" 1 Important: Save the new XLS worksheet with a suitable filename & confirm this is displayed on this sheet cell H36
12 2 \Write the directory path and filename for the FSF reference panel calibration data spreadsheetinto cells P27 & P30 respectively. Name: Shortcut  Operation
13 3 Select the serial number of the reference panel used during the measurements. Load_pan_cal Ctrl+b Load FSF panel calibration data.
b s _pan_cal (Cirl D) fo mport e absolute reflectance values for he reference panel
18 5 Runthe macro Load_ASD_Dialog (Ctri + ) to select and import the ASD, ASCII text, Raw (DN) data files. Load_ASD_Dialog Ctrl +p  Import ASD Raw (DN) data files.
16 The template can import up to a maximum number of 255 raw ASCII text data pairs, to create a maximum of 254 reference and target file
17 pairs. cal_reflect Ctrl + 1 Ratio Target & Ref. files
18 6 Check the data has been correcty imported into the worksheet ASD ASCII Files.
19 7 Identify the reference and target files pairs in row 1 of the * ta Normalised' worksheet. plot_rel_reflect Ctrl+ g Graph first 25 absolute reflectance spectra
20 8 Use the macro shortcut keys Crtl + 1 or run the macro cal_reflect to pair up ref & target files and calculate reflectance spectra.
21 9 The first 25 absolute reflectance files can be graphed with their water bands removed using the macro shortcuts Ctrl +g and Ctri +w rem_wtr_bands Ctrl +w  Remove data from water absoption bands
22
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e
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e Save the spreadsheet as an .XLS document (or .xIsm in Excel 2007) with a
name and in a directory of your choice. The new name is displayed in cell H36
of the Input Parameter worksheet. Do not enter the filename directly into cell
H36.

Setting up the Excel Template Parameters
The Input Parameter worksheet allows the user to select the path\directory and
root filename for the reflectance panel calibration file, as well as the actual

reflectance panel used for the reference measurements.

e Click on cell H27 to bring up the pop down menu button. Click on the button to
display the serial numbers of the NERC FSF calibrated Reflectance panels.

Reflectance Panel: SRT13160A ___|5)
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Input Parameters -Cell H27
Reference Panel selection menu

w
5

w
&

Excel Spreadsheet Fil : ASD WRef Reflectance Template_Ver 01.XLT

e Select the serial number of the panel used during the Reference measurement.
This will be used to convert the relative reflectance values into absolute
spectral reflectance data. If you do not require absolute reflectance data select
‘Panel Not Selected’ from the list.

e Sun Angle Correction has not been implemented into the template at this
stage.

e Set the Reflectance Scale (cell H33) to the desired level. Typically this is 1 or
100.

e The calibration data for the Reflectance panels is stored in a separate Excel
spreadsheet. Enter into cell P27 the directory path where this spreadsheet is
located on your computer.

e Enter into cell P30 the name of the Spectralon panel calibration spreadsheet
file. NOTE: It is important to ensure that the Reflectance panel calibration file
corresponds to the same year that the measurements were taken. Files from
previous years are archived on the FSF website, please contact FSF for further
advice on this.

Macro for Importing the Selected Spectralon Calibration Data

Before the data can be processed it is necessary to run the macro /load_pan_cal.
This will read the selection in cell H27 and import the calibration data from the
panel calibration spreadsheet into column B of the Absolute Reflectance worksheet.

e Use the short-cut keys Ctrl + b to load the selected panel calibration data.

The Excel spreadsheet is now ready to import the ASCII converted raw data files.
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Importing Data with the ASD Raw Reflectance Data template Macro *

The Excel template can import up to a maximum of 255 ASD ASCII raw data files
from the selected directory.

The ASCII text file created by ViewSpec Pro for a raw file comprises of a header
with measurement parameter information, a column with the wavelength scale and
a column with the raw spectral data.

e To import the ASCII text files run the Load_ASD_Dialog Macro from the
Tools \ Macro\ Macros menu or use the short cut keys Ctrl + p to bring up
the dialog box and then select the text files (already converted to ASCII in
section 1) you wish to process.

erence panel used during the measurements Load_ASD_Dialog  Ctrl +p
trl + b) to import the absolute reflectance values for the reference panel. plot_rel_reflect Ctrl+g
o o DN Sl
[ 2| x
murn i M 2
Lookin: [ wr_version5.5.10 ] @ -3 Q X L & - Tooks -
"

importe

&

My Recent
Documents

Desktop

iles can

St EV‘OCeSSir‘II

Cal Data_new_nf

------ My Documents

-
e
------- .‘:!ra
My Computer
e
File name: -
- = QOpen
My Network I J ==
Places  Filesoftype: [Text Fies (*.om; *.txt; *.csv) = Cancel L

The template and its Macro \ Visual Basic code import all the ASCII converted data
files that have been selected from the *file open’ dialog box.

During the import procedure the data files names will appear and disappear from
the Windows task bar. The procedure can take several minutes depending on the
number of data files selected and the speed of your computer. Additional delay may
be added as normalisation factors are calculated for each file depending on the
integration times and amplifier gain settings.

The ASD Data Normalised Worksheet

This worksheet shows the original data |, — 2 8 [ ¢ [ ©
A ) . eference Column: | Ref B B
with the file header slightly reformatted. 2| Filename: 0A00axt  QAOZina QA2
L=n] H_Filename: QA 020 QA 021 QA 022
| 4 | ASD Serial # 6449 6449 £449
5 INI Cal # 1 i) 1
Note- i Program :’ersion: 203 203 203
- 7 File Version: 4.03 4.03 4.03
During importation the Excel macro % Elez{it'::! e
o o q ile Time: () I
checks each file’s header to confirm if | [i0 vuR e Time: 136 136 13
the files are Raw data (DN) | |11 \nChanne =0 ¥ e
| 12 | gth Int: 1 1 1
i i | 13| Averaging: 25 25 25
measurements._Date files which do not 2 2 2
comply are not imported. 15 SWIR1 Offset 2073 2073 2073
16 SWIR2 Gain: 24 24 24
E SWIR2 Offset: 2086 2086 2086
18 Join 1: 1000 1000 1000
E Join 2: 1830 1830 1830
. . . . 20 VHIR DC: b d I d b d
Row 1 (highlighted in red) is used to | ocaveraging R
manually identify the Reference files or in |5 & = s .
the case of Target files row 1 contains the g Ve efasetcs: Mot Used Mot Used Hot Used
column letter for this Target's Reference [z  ForeOptic 5-degree 5-degre 5-degree
file. In the example shown, the Target [  wavelongn e e T
T H 29 350 302.7957764 1045591518 11.39436626
files in columns C & D both use the [ - T sty =
reference file in column B. 31 352 354 6244751 130979023 120979023

2 Running this macro will disable the Auto Complete Cell option. To re-enable this, select
Options from the Tools menu and check the Enable AutoComplete...box in the Edit tab.
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e Use your log sheets to carefully identify the reference files as “"Ref” or “ref” in
row 1 of the ‘ASD Data Normalised’” worksheet.

e Each Target file now needs to be linked to its reference file, in row 1 of each
Target file enter the column letter for the corresponding reference file.

When a rigid sampling scheme has been maintained the strings stored in the
Example RT Strings worksheet can be copied and pasted into row 1 of ASD ASCII
Data worksheet.

A [INE D E F G H o O O - |
| 1 | Reference Column: Ref B Ref D Ref F Ref H Ref J Ref
2
3 | Reference Column: C Ref E Ref G Ref I Ref K Ref 1]
4

Reference and Target strings from the Example RT Strings worksheet

Running the Reflectance Ratio Macro

The raw spectral data files are now ready to be paired together and have their
relative reflectance values calculated. The Excel macro cal_reflect (short-cut key
Ctrl + r) will search through the ASD Data Normalised worksheet matching the
Target files with their nominated reference files. These two files are copied into the
ASD Ref & Target Files worksheet where the relative reflectance values are
calculated.

e Use the macro short-cut key Ctrl + r start pairing of Target and Reference data
files.

Note:
The cal_reflect macro will not run if the ASD Ref & Target worksheets have old
data in them. A warning dialog will appear if the macro detects old data. Old
data must be first cleared (except column A) before running the macro.

This macro may take several minutes to copy the paired files into the ASD Ref &
Target Files worksheet and calculate the reflectance values. At the end of the macro
sequence a warning dialog will appear three times seeking confirmation for the
deletion of the ASD ASCII files, Norm Coefficients, and ASD Data Normalised
worksheets. In normal operation all these files have been paired and copied into
ASD Ref & Target Files worksheet.

Microsoft Excel

! ': Data may exist in the sheet(s) selected for deletion. To permanently delete the data, press Delete.

e Select Cancel if you wish to keep the extra worksheets.
e Select Delete if you wish to reduce the Excel spreadsheet file size.

A [ B I B [ D
1 | Reference Column: | B Ref
| 2 | Filename: QA.021.txt QA.020.xt
=5 H_Filename: QA.021 QA020
| 4 | ASD Serial # 6449 6449
5 INI Cal # 1 1
| 6 | Program Version: 203 2.03
| 7 | File Version: 4.03 403
| 8 | File Date: 24/05/2006 24/05/2006
25 File Time: 12:01:24 12:00:51
| 10|  VNIR Int. Time: 136 136
| 11| VHIR Channel #1 350 350
| 12|  Wavelength Int: 1 1
| 13| Averaging: 25 25
| 14 | SWIR1 Gain 48 48
| 15 | SWIR1 Offset 2073 2073
| 16 | SWIRZ Gain: 24 24
| 17 | SWIR2 Offset: 2086 2086
| 18 | Join 1: 1000 1000
19 Join 2: 1830 1830
The ASD Ref & Target WorkSheets E VHNIR DC: subtracted subtracted
| 21 DC Averaging: 25 25
| 22 | DC Time: 11:69:15 11:59:15
| 23 | DCC: 0 0
| 24|  White reference: Mot Used Not Used
| 25| WRef Averaging:
| 26 | Fore Optic S-degree S-degree
| 27 | Data: raw raw
Page 10 28|  Wavelength QA021 QA 020 Reflectance
129 | 3850 10.48591518 3027957764 0034630322
30 351 12.39860153  328.7482605  0.037714577




In this worksheet column A shows the wavelength scales and the file header titles.
Subsequent columns (B,C and D in the example shown) display the raw target
data, raw reflectance data and the Excel calculated relative reflectance values.

On this worksheet it is possible to compare the pairing up of the target and
reference data files by viewing the file names, scan times and reflectance values.

Up to 85 Target/Reference/Reflectance data files sets can be viewed on this work
sheet. ASD Ref & Target Worksheets II and III are used to store additional files.

The Absolute Reflectance Worksheet A ! B [ c

Relative spectral reflectance data from the ; R‘fﬂrget F"Fe,:‘“'“ei gf“ggsi’“

. .. 1 txt

ASD Ref & Target worksheet is multiplied | clefonce TronAmOA

with the calibration data of the selected | Ref. Panel Absolute
Reflectance panel (Input parameters 5 |Wavelength SRT 131604 Reflectance
: 5 95 2% 33
worksheet, cell H27) to give the Absolute |°© 0 3.2 33
Spectral Reflectance values. g 350 g5 29, 352
9 353 95.2% 346
Up to 254 absolute reflectance spectra are |10 354 3.3% 5o
: ) K 355 95 3% 317
saved into this worksheet. 2 156 95 39, 340

Graphing Absolute Reflectance data with the Template Macro
A simple graphing macro plot_abs_reflect is available to graph the first 25
spectra in the Absolute Reflectance worksheet.

e Select from the Tools\Macro|Macros menu plot_abs_ reflect or use the macro
short-cut keys Ctrl + g to plot up to 25 spectra in the Absolute Reflectance
worksheet.

Absolute Reflectance

60.00

50.00

40.00 -

30.00

Reflectance
Ay

20.00 +—-

10.00 4

0.00 4 ‘ ‘
350 850 1350

Wavelength (nm)

1850

X-Y scatter plot of absolute reflectance data using the plot_abs_reflect macro (short-cut
keys Ctrl + g)

Removing data from the Atmospheric Water Absorption Bands

Under certain measurement conditions the atmosphere can strongly absorb the
incident downwelling radiation in two bands (1350-1460nm & 1790-1960nm) of the
shortwave infrared region. As a result the reflectance data can appear very noisy in
these regions. The template macro rem_wtr_bands deletes data across these
bands in Absolute Reflectance worksheets. Note the ASD ASCII data remains
untouched by this macro.
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e Start the rem_wtr_bands Marco from the Tools \ Macro\ Macros menu or use
the short cut keys Ctrl + w

Absolute Reflectance

60.00

= i

o~ | 7 3
N P v

50.00

40.00

30.00 L =

Reflectance
N

20.00 +—-

10.00

0.00 4 ‘
350 850 1350 1850

Wavelength (nm)

Note:
The spreadsheet can now be saved for further processing.

X-Y scatter plot of absolute reflectance after the data in the water bands has been removed
using the macro rem_wtr_bands (short-cut keys Ctrl + w)
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4. Post Processing ASD Radiometric Data Files

Each of the Field Spectroscopy Facility’s ASD FieldSpec Pro spectroradiometers has
a number of optional fore optic accessories, which can be configured for spectral
radiance or spectral irradiance measurements. However each configuration will
have its own unique calibration file*> and it is essential that this file be used when
converting raw spectroradiometric data into absolute radiance or irradiance values.
The Excel template, which performs the necessary calculations on the ASD
FieldSpec raw data, is described below. The template includes the calibration files
for a variety of optical configurations.

Excel Macro Security Level
Before the Excel templates can be opened it is necessary for the Macro Security
level be set to allow the template’s macro and Visual Basic code to be enabled.
e From the Excel Tools menu select Options and the Security tab.
e Click on the Macro Security button and change the Security Level to
Medium.
e If using Excel 2007 click on the ‘office’ button in the top left corner of the
screen. Excel options — Trust center. Trust center settings — macro settings
- enable all macros - OK.

This will allow the macros to be manually enabled when opening the Excel
template.

Opening and Saving the ASD FieldSpec Radiometric Calculator Template

e Start Excel and from the File menu Open and [EEEEEALHNL-
select the FSF Excel template for calculating |- oo s sine.
absolute spectral radiometric values from raw |=° e e me s e

ASD (ASCII) data files:

Macros may contain viruses. Tt is usually safe to disable macros, but if the
macros are legitimate, you might lose some functionality.

ASD FieldSpec Radiometric Calculator_Ver 03.XLT

[ Enable Macros ] [ Mare Info

e In the Security Warning dialog click the Enable Macro button.
The new spreadsheet will open on its Input Parameters worksheet as shown below:

e Save the spreadsheet as an .XLS document with a name and directory of your
choice. The new name is displayed in cell H28 of the Input Parameter

worksheet. s
] | e YA |
goo-A-50
= 3 i T Tk W () a R S |
E ® NERC Field Spectroscopy Facility
Note: ; ASD E)fcel Temp for C ing Spectral i & Irradi ¥ Excel 2007 compativle i
As the template is a read | = =
only document it needs to | 3| :
be opened and renamed as || : I ——
an Excel .XLS worksheet, R e s i
prior to running the | [ cowene
macros. , imadianceRadiancs Range: [ 200] 1o~ [Z500]
If using Excel 2007, it will | 2 oo r B 5 S B e
need to be saved as a .xIsm | |: [esci ’ 45D Systm e Fiename: - [T i ]
(macro enabled excel o : e (PR oyt e et
worksheet). oo Ry e —
‘g mmmmmmmmmmmmmmmmm & Wt Jl |

nnnnn

Spectral radiance & Irradiance Calculator spreadsheet.

3 .
Unlike the more commonly measured spectral reflectance.
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Setting up the Excel Template Parameters

The Input Parameter worksheet allows the user to select the instrument serial
number, the calibration file that corresponds to the optical configuration used with
the instrument, the measurement units and Radiance / Irradiance range. The user
also needs to specify the path/directory and root filename for the system response
calibration file here.

e The serial number of the spectroradiometer must be recorded into cell H22.
This is used to all ensure the data files match and to assist in the generation of
the normalising coefficients.

Note:

It is critical that the correct system response calibration file is selected. Please
ensure the instrument serial number and fore optic exactly matches your
measurement setup. A warning label is shown in cell N24 to indicate the
mismatch of the ASD serial number and the selected calibration file. This will
clear when the setup process is correctly completed. It is also important to
ensure that the system response calibration file corresponds to the same year
that the measurements were taken. Files from previous years are archived on
the FSF website, please contact FSF for further advice on this.

e Click on cell H24 to bring up the pop down menu button. Click on the button to
display the 18 calibration files available for the ASD field spectroradiometers
and their various Fore Optic accessories.

[00. Not Selected -

00, Mot Selected

1. ASD # 6032 T Fore Optic

02, A50 # 6032 & Fore Optic

03. A50 # 6032 18 Fore Dpic

04, 250 # 6032, Remote Cosine Recephor

05. A50 #6239 I Fore Optic

0. A50 # 6239 % Fore Optic

07. ASD # 6239 19 Fore Dptic 5

e From the drop down list select the system response calibration file, which
matches the serial number of the ASD spectrometer used, and its fore optic.
This will be used to convert the raw data values into absolute spectral radiance
or irradiance.

e Confirm the warning label in cell N24 is now cleared.

e Click on cell H26 and select from the drop down menu your measurement type
and preferred units.

- Radiance mW m2 sr! nm™

- Radiance pyW cm™ sr't nm™

- Irradiance mW.m™2 sr't nm™

- Irradiance pW.cm™? sr't nm™

e The system response calibration data for the ASD with its foreoptic is stored in
a separate Excel spreadsheet. Enter into cell P30 the directory path where this
spreadsheet is located on your computer.

e Enter into cell P32 the name of the Spectralon panel calibration spreadsheet
file.
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e Enter into cells R26 and T26 the desired range over which the radiance /
irradiance value is calculated. The maximum range from 350 to 2500nm. Note
R26 must be less than T26. The radiance/irradiance values are shown in the
Absolute Radiance (Irradiance) worksheet.

e Change cell P34 to ‘yes’ if GPS information has been used as an additional data
input during data collection, and you wish to retain it in the file header. The
default for this is ‘no’.

Running the template Macros

The Excel template includes four macros
- To load the ASD’s system response calibration file

- To import, format, normalise to unity gain / integration time and calculate the
radiometric values from the ASD ASCII text data files

- To graph the first 30 calculated radiometric data files
- To recalculate the irradiance/radiance values

Each of these Excel macros can be run from the Tools / Macro menu or by using the
short-cut keys listed on the Input Parameters worksheet.

Macro for Importing the System Response Calibration Data

Before the data can be processed it is necessary to run the macro
load_sys_res_cal. This will read the selection in cell H24 and import the calibration
data from the radiometric calibration spreadsheet (detailed in cells P30 and P32)
into column B of the Absolute Radiance (Irradiance) worksheet.

e Use the short-cut keys Ctrl + b to load the selected system response cal. data.

Importing Data with the Load_ASD_ASCII_data_file_dialog Macro

The excel template can import up to a maximum of 102 data files for processing.
The ASCII text data files (which should already have been converted in ViewSpec
Pro - see section 1) comprise of a file header with measurement parameters, a
column with the wavelength scale (350 - 2500nm, 1nm interval) and a column with
the raw spectral data.

e Start the Load_ASD_ASCII data_file_dialog Macro from the Tools \ Macro\
Macros menu or use the short cut keys Ctrl + p

e A ‘File open’ dialogue box will prompt you to navigate to the relevant directory
and select all the .txt files that you wish to import into the template. Highlight
these and then click ‘open’.

units from the drop down menu at cell H26.
F system response calibration spreadsheet you will be using into cell P30. Ctrl+p Us
A& File Open 21|

asin Look in: IJ ViewSpec Pro v5.6.10b j -3 Q X iy EF - Toos~
pre a3

d ce i c:).

Exce My Recent
Documents

Desktop

Pl

Re

.
e S r anc
My Documents
-—- =1 g
-l
. =
My Computer @
i \';l
s z |
- File: name: % Open
My Network : I J = —
Places Files of type: IText Files (*.prm; *.txt; *.csv) j Cancel ;
4
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The template and its Macro \ Visual Basic code import all the data files selected in
the dialogue box, up to 102 files.

During the importation procedure the data file names will appear and disappear
from the Windows task bar. The procedure can take several minutes depending on
the number of data files selected and the speed of your computer. A further delay is
to be expected as Excel calculates the normalising coefficients for each point in
each spectral file over the range 350 - 2500nm.

The ASD ASCII Files worksheet A B G D
H H H ﬂ Filename: 100_8.000.txt 100_8.001.txt 100_8.002.txt
Thls ShOWS up to 102 raW data ﬂles Wlth 2 H_Filename: 100_8.000 100_8.001 100_8.002
the file header formatted into one column. | 3| AasDseriai# 6032 6032 6032
. . . 4 INI Cal # 3 3 8]
Data stored in the files header includes:- B Froaram Version: 9 9 9
- H H 6 File Version: 403 403 403
ASD serlal number & se_ttlngs 7 File Date: 22/02/2006 22/02/2006 22/02/2006
- Measurement dates & times 8 File Time: 17:33:45 17:33:50 17:33:53
. . 9 VNIR Int. Time: 136 136 136
- Dark signal averaging 10| VNIR Channel #1 350 350 350
- i 11| Wavelength Int: 1 1 1
Measurement av_eraglng B At 3 - -
- Fore optic selection 13| SWIR1 Gain 16 16 16
p
14 SWIR1 Offset 2050 2050 2050
- Measurement type 15 SWIR2 Gain: 16 16 16
16 SWIR2 Offset: 2078 2078 2078
17 Join 1: 987 987 987
18 Join 2: 1795 1795 1795
19 VNIR DC: subtracted subtracted subtracted
20| DC Averaging: 25 25 25
21 DC Time: 22:33:23 22:33:23 22:33:23
22 DCC: 0 0] 0
23 | White reference: not not not
24 Fore Optic 8-degree 8-degree 8-degree
25 Data: raw raw raw
26 Wavelength 100_8.000 100_8.001 100_8.002
27 350 22 36859131 2321239471 22 36253548
28 351 23.50943756 24.59971809 23.99633789
The Norm Coefficients Worksheet A B C D
Each spectral data files has a column of | 1 | |100_8.000 100_8.001 100_8 002 2
coefficients generated to normalise the g VS’\J\LS'F'{TSIWG 1?2 1?2 132
- ain
data _ _for c_hange_s in I_nGaAs detector | e I e i
amplifier gains or integration times for the | 5 Jeain 087 087 987
VisNIR silicon array detector 6 Join 2 1795 1795 1795
Data extracted from the file headers ; gg? Eg }32 gg
includes the \_/ISNIR mtegratlon time, | - 136 o =
SWIR1 & 2 gains and Join 1 & 2, the 10 353 136 136 136
wavelength at which the spectral data |1 354 138 136 136
switches from the channels 1 to 2 and |2 - s 135 L
h |2 to 3 13 356 136 136 136
channe : 14 357 136 136 136
15 358 136 136 136
16 359 136 136 136
17 360 136 136 136
18 AR 138 138 138

Norm Coefficients Worksheet
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The Absolute Radiance (Irradiance) Worksheet

Spectral data from the ASD ASCII worksheet is normalised using the coefficients
above and scaled to absolute radiometric values by multiplying each spectral value
with its unique cal. factor from the chosen system response calibration file.

A B | C | D | E | F | G

% Filename: RAD_8DEG.000.txt RAD_8DEG.001.txt RAD_8DEG.002.txt RAD_8DEG.003.txt RAD_8DEG.004.txt H
ER Radiance: W/m#sr 110.3 110.3 110.3 110.3 110.3
| 4 | PAR ( pmolim?s): 65.3 65.3 65.3 65.3 65.3

5 Luminance: cd/m? 3326.3 3326.3 3326.3 3326.5 3326.3
5
| 7 | Spectral Units:| m\W.m-2.sr-1.nm-1) mWW.m-2.sr-1.nm-1 m\W.m-2.sr-1.nm-1) mWom-2.sr-1.nm-1) mWW.m-2.sr-1.nm-1
| 8 | Cal File Date: 29 March 2007 Spectral Spectral Spectral Spectral Spectral

9 |Wavelength (nm)| Selected Cal File Radiance Radiance Radiance Radiance Radiance
| 10 350 2.076 1.672 1.661 1.658 1.650 1.650
| 11| 351 2.010 1.719 1.712 1.700 1.704 1.697
12 352 1.960 1.751 1.767 1.750 1.780 1.744
|13 ] 353 1.582 1.516 1.618 1.8603 1.626 1.803
|14 354 1.822 1.876 1.867 1.862 1.878 1.862
| 15 | 355 1.774 1.932 1.916 1.924 1.934 1.921
| 16 356 1.726 1.995 1.983 1.980 1.996 1.965
| 17| 357 1.685 2.051 2.044 2.037 2.047 2.031
| 18] 358 1.647 2103 2.102 2.096 2.099 2.098
|19 359 1.610 2.150 2.156 2159 2.166 2.148
| 20 360 1.574 2.214 2.207 2.214 2.230 2.217
|21 361 1.542 2.280 2.269 2.272 2.289 2.281
|22 362 1514 2.346 2349 2339 2344 2333
| 23] 363 1.492 2.413 2410 241 2413 2.397

Absolute Radiance (Irradiance) Worksheet

The data is further scaled to match the selected measurement units for radiance or
irradiance measurements, depending on the units selected in cell H26 of the ‘input
parameters’ worksheet:

- Radiance mW m2 sr'! nm™
- Radiance pW cm™@ sr'! nm™

- Irradiance mW.m™2 sr'* nm

- Irradiance pW.cm? sr't nm™

Rows 3, 4 and 5 of the Absolute Radiance (Irradiance) worksheet display the
radiance (irradiance), PAR and luminance (illuminance) for each of the spectral data
files. The radiometric data is calculated over the spectral region selected in cells
R26 and T26 of the Input Parameters worksheet.

e Use the short-cut keys Ctrl + h to run the template macro recal_rad_values
which recalculates the radiometric values after making changes to the
irradiance/radiance range cells (R26 & T26).
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Graphing Radiometric Data with the Excel Macro plot_rad_irrad

The graphing macro plot_rad_irrad automatically plots the first 30 available
spectra in the Absolute Radiance (Irradiance) worksheet.

e From the Tools\ Macros menu select and run the macro plot_rad_irrad or use
the macro short-cut keys Ctrl + g

[=

—— VER_8DEG.000.txt

Radiance VER_8DEG 001 txt
artives — VER_8DEG.002.txt
250.0 — VER_8DEG.003.1xt

—— VER_8DEG 004 txt
—— VER_8DEG 005 txt
—— VER_BDEG.006.txt
200.0 —— VER_8DEG 007 txt

VER_8DEG 008 txt

VER_8DEG.009.txt

VER_8DEG.010.txt

VER_8DEG.011.txt

VER_8DEG 012 tst
~— VER_8DEG.013.txt

VER_8DEG.014 ixt
—— VER_8DEG.015.txt
—— VER_8DEG.016.txt
—— VER_8DEG.017.txt

VER_8DEG.018.txt
—— VER_8DEG.019.txt
—— VER_8DEG.020.txt
—— VER_8DEG.021.txt
—— VER_8DEG.022 txt
—— VER_8DEG.023.txt
—— VER_8DEG.024 txt
—— VER_8DEG.025.txt
—— VER_8DEG.026 txt
—— VER_8DEG.027 txt

150.0

mW.m-2.sr-1.nm-1

350 850 1350 1850 2350

Wavelength (nm)

M« » )\ Input Parameters ' Radiometric Plot{ Absolute Radiance (Iradiance Norm Coefficients 4 ASD ASCII Fies 4 Mc[<] [ m 1 (2l

Ready UM

X-Y scatter plot of absolute spectral radiance in mW m™ sr'* nm™ using the macro plot_rad_irrad

Note:
The spreadsheet can now be saved for further processing.
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